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Getting Started 

Running Accelerus 

• If there is an Accelerus icon on your desktop, you should click it to run Accelerus. 
OR 

• From the Start menu, click All Programs. 
• Click the Accelerus folder. 
• Click Accelerus. 

Logging in 

When you run Accelerus, the Login 
window will be displayed. Everyone 
must log in to Accelerus in order to 
access their classes and enter their 
students’ results and comments. 

It will give you options to: 

• Open your offline class file. 
• Collect an offline class file, 

which you may need to do 
when first using Accelerus. 
Instructions for this can be 
found in the Collecting and 
Synchronising Offline Files 
notes, available from the 
Accelerus website. 

• Connect to an Accelerus 
database, if the Accelerus 
administrator has allowed you 
access to the database. 

First log in 
The first time you connect to an 
Accelerus data source, either an offline file containing your classes or your school’s Accelerus database, you should: 

• Select the appropriate option, eg I want to open an offline file... or I want to connect directly to a database ... 
• Select from the suboptions that are then presented to you. 

For example, if using an offline file: 
• If you know where your file is, select the option I know where my file is and wish to browse for it... 
• Try one of the options that scan your USB 

drive or computer for offline files. 

• How you proceed will depend on how your school has 
set up the login processes for Accelerus: 

• You may be logged directly into Accelerus, 
based on the login credentials you entered to 
login to your computer, and not have to enter 
further login details. 

OR 
• An Accelerus Login box will be displayed. 

It will inform you whether you must enter your Windows login details or your Accelerus user name and password, or if either is 
acceptable. 

• Click Login once you have entered your user name and password. 
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Subsequent logins 
Once you have logged in to your offline file or the Accelerus 
database, next time you run Accelerus you will be prompted 
to open the same data source, rather than have to find it. 

As shown here, the welcome message informs you of the 
most recent login. To login to this same file or database: 

• Click it. 
• Depending on your school’s Accelerus login settings: 

• You will be logged directly into Accelerus. 
OR 
• An Accelerus Login box will be displayed in 

which you enter your login credentials, ie 
either your Windows login details or your Accelerus user name and password, as stipulated in the Login box. 

• Click Login once you have entered your user name and password. 

You may also login to a different file or database, if required, in which case the appropriate one of the Other options should be selected. 

Changing your password 

It is very important that, once you have logged into Accelerus, you 
change your Accelerus password: 

• Go to the File menu. 
• Click Change Password. 
• Enter your current password. 
• Enter your new password and then reenter it to confirm it. 
• Click OK. 

If you forget your password, see your Accelerus administrator to 
assign a new one, or see your school’s computer technician if you normally use your Windows login credentials to login to Accelerus. 

The Welcome Screen 

Once you log in, Accelerus opens up to its Welcome 
Screen. The title bar displays your name, the school 
name and the academic cycles to which your classes 
belong, eg Sem1, 2011. 

All of your classes for the displayed academic cycles 
will be listed in the Welcome Screen. From here you 
may click a class to open it and work on assessing the 
students in the class. 

Any comment banks you have will also be listed. In 
addition, you may click the Comment bank explorer 
icon to work on comment banks, as covered in the 
Working with Teacher Comment Banks notes. 

You may open as many of your classes 
simultaneously as you wish, via the Welcome Screen. 

As you open and close class files, you will be returned 
to the Welcome Screen, from where you select further 
classes or perform other tasks allowed in Accelerus. 

You may return to the Welcome Screen at any time 
while in Accelerus in any of the following ways: 

• Clicking the Show welcome screen icon in the toolbar. 
• Going to the Window menu and selecting it from there. 
• Pressing Ctrl W. 
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Working on Class Results 

Saving your work 

When working in your offline file, save your work regularly: 

• Press Ctrl S (a shortcut well worth remembering). 
OR 

• Click the Save icon in the toolbar. 
OR 

• Click File in the menu bar, then Save Results. 
 

Navigating around your class 

Accelerus works like most Windows applications, having such features as dropdown menus and shortcut keys, eg Ctrl S for Save. In most 
places, you may right-click to bring up an appropriate menu. Also, you may have multiple classes open at once, each opening in its own 
tabbed window. You may switch between classes by clicking the tab of the window you want to bring to the front. 

Navigate your way around the results grid in your classes using any of the following: 

• Point and click in the cell you require 
• Use the arrow keys (↑ ↓ ← →) 
• Press Tab to move right one cell and Shift Tab to move left one cell 
• Press Enter to move down one cell, and Shift Enter to move up one cell 

Closing 

To close the class you are working on: 

• Firstly, save it. 
• Click File, then Close Results. 

OR 
• Click the Close button on the tab for the particular class. 
 
To log out, which will return you to the Login window so that another user may log in: 

• Click File and then Logout. 
• Follow the steps on page 3 to log in as a different user or to a different 

offline file. 
 
To exit Accelerus completely: 

• Click File, then Exit. 
OR 

• Click the Close button at the top right corner of the Accelerus window. 

When you close, logout or exit, you will be prompted to save any unsaved work. 

Assessment item columns 

Columns are headed by an assessment item code, eg T1ACH. Each 
column is one item of assessment. 

If you hover your mouse over the column heading, additional 
information about the assessment item is displayed: 

• The full description of what is being assessed. 
• The values that may be entered, ie the valid marks or grades. 
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• If the item is a comment item, the maximum number of characters that may be entered. 
• Where only numbers may be entered, the minimum and maximum, plus any rounding, is displayed. 

In addition, special icons will appear in the assessment item heading when: 

• A column has been locked and, therefore, is not able to be modified. 
• A calculation has 

been entered for the 
assessment item, in 
which case the 
results therein will be 
automatically 
calculated. 

• The column is a 
class assessment 
item, created by a teacher of the class. 

Locked and calculated columns appear shaded, as seen with CLA01 and TOTA1 respectively above. 

Status bar and panel 

Along the bottom of the class window either a status bar or an 
optional panel will be displayed, giving more information about the 
assessment item. 

In the case of the status bar, where student photos have been 
brought into your school’s database, a thumbnail photo of the 
student currently being assessed is displayed. 

Clicking the thumbnail in the status bar will enlarge it. Click it 
again to go back to a thumbnail. 

The optional panel at the bottom of the window, on the other hand, not only 
shows full details about the assessment item, but also more information about 
the student, including their photo, where available, as shown below. 

 

Display this panel or hide it, as you wish, by clicking the 
divider above the panel or status bar, as shown to the left. 
 
 
 

Entering non-comment results 

Move to the cell where you want to enter results: 

• Simply type in the result required. 
OR 

• Click the dropdown arrow beside each cell 
belonging to an assessment item that has a list type 
of marking scheme (eg A, B, C ... or Excellent, Very 
Good, ...) and: 

• Click the required result in the dropdown list. 
OR 

• Use the up and down arrow keys to move to the value required, pressing Enter when positioned over the required value. 
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Changed and incorrect results 

When you make a change to a student 
result, it will be indicated by a green 
triangle in the top right corner of the 
relevant cell. 

When a cell contains an error, eg a 
value that is not allowed or a comment 
that exceeds its maximum number of 
characters, a red exclamation mark 
appears in the right of the cell. 

If you hover over the red exclamation 
mark, you are informed of the reason for the error, as well 
as the original value of the cell. In the case of changed 
values, if you hover over the green triangle, the original 
value will be displayed. 

In the case of both changed and incorrect values, you may 
revert to the original saved value by right-clicking over the 
cell and selecting the Revert to saved value option from the 
menu. 

You will not be able to save your work if the class contains 
invalid results – you will need to correct these first. 

Once you have saved your work, the green change triangles 
disappear. 

 

Entering comments 

For comment assessment items, a limit on the number of characters able to be entered is often set. 

This limit is shown in the status bar or bottom panel, if displayed. As soon as the limit is reached, a red exclamation mark will appear in the 
comment cell. 

In Single student view, the window designed for drawing upon comment banks, a 'fuel gauge' indicates how close to the limit you are. 

Although you may type comments directly into a comment cell – expand the column width and row height first – usually Single student view 
is used for comments. 

Typing in Single student view 
• Move to Single student view using any of these 

methods: 

• Click the Single student view icon in the tab at 
the bottom right of the class result grid. 

• Go to View > Single student view. 
• Press Ctrl T. 
The Single student view window will be displayed 
with all comment 
assessment items in the 
top pane, and non-
comment items listed 
along the right side. 

• Type directly in the 
particular comment box, 
if you wish. 
As you do so, a gauge 
will indicate how much 
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of the comment’s character allowance has been used up. The gauge will turn amber when 75% of the limit is reached and red at 
90%. 

• Click the Next or Previous student arrows, at the end of the Student field in the top left corner, to move to another student for whom 
you wish to add a comment. Alternatively, pressing Alt N or Alt P respectively will move you to the next or previous student. 

Using comment banks 
Schools often set up 
comment banks for the use 
of teachers and assign 
them to teachers’ subjects. 
In addition, teachers may 
create comment banks for 
their own use. 

These comment banks are 
stored in the teachers’ 
offline files so that they may 
be drawn upon when 
assessing students. 

This is done in Single 
student view, with any 
available comment banks 
being displayed in the 
comment bank panel. 

The school comment banks 
will appear greyed out so 
that they may not be 
changed, but can be drawn 
upon. Comment banks 
owned by the teacher may 
be modified and drawn 
upon. As shown here, there 
are two school comment 
banks – Generic and Maths 
– plus Maths 7-9 and Work Habits, both of which are teacher comment banks. 

To use the comment banks: 

• Click in the particular comment box for which you want to compose comments, eg T1COM – Interim 1 comment above. 

• Click on the comment bank 
that you want to draw 
comments from, eg Work 
Habits. 

• Click on a category of the 
comment bank, eg General 
Performance, 
Organisational Skills, etc. 
All of the comments for that 
category will be displayed, with their values. 

• Click on a performance value for the 
category, eg Satisfactory, and the comments 
for that Category and Value will appear in the 
Comment table. 

• Change the name substitution mode by 
clicking the Name or Pronoun button, if 
necessary. 
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• If buttons appear for Given name and Preferred name, click the required option to display the comment with the chosen name format. 

• Double-click a comment in the table to insert it into the comment box. 

• Continue selecting comments in the same way for the current student. 

• Do as much editing and 
changing of the text in the 
comment box as you wish – 
right-clicking brings up an edit 
menu, or use short-cuts. 

• Correct spelling errors as you 
go when squiggly red 
underlining appears, right-
clicking on the misspelt word 
to bring up alternatives. 

• Click the Next or Previous 
student arrows to move down or up the student list. 
OR 

• Press Alt N or Alt P respectively. 

• Keep entering comments for students in the same way. 

• Click the Save icon or press Ctrl S regularly to ensure the comments you have been entering are saved. 
 

 

Your school may have activated a setting that does not allow you to type beyond the number of characters specified for a 
particular comment. In this case, any comment you insert, that would take you beyond the comment’s maximum 
characters, will be truncated. 

Alternatively, the school setting may allow you to continue entering comments but the comment box will be shaded red 
and the comment will need to be edited to fit within the number of characters before you can save the offline file. 

 

Editing tools & procedures 

The tool bar contains various 
editing tools, as well as some of 
the other tools already covered 
in these notes, eg Save results. 

These tools allow you to modify 
and perform various editing 
functions on your data such as 
search for and replace 
specified text, copy a result all the way down or up a column, copy columns of results to other columns, etc. 

Hover over each of the toolbar icons to display their function, eg Sort ascending, as shown above. 

Selecting columns 
Many different procedures may be performed on whole columns or even multiple columns, eg Copy and paste, sort, etc. 

You may select an individual column or multiple columns: 

• Move to the heading of the column you require and click your mouse button. 
The whole column will become highlighted. 

• Hold down the Ctrl key while selecting other individual columns by clicking their column headings. 

• Move to the last column you want to select and, holding down the Shift key, click the column heading. 
In this case, all columns between the first and last selected will be highlighted. 

Once the columns are highlighted, they are available for you to perform various functions, eg to move the columns to a different position. 
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Changing or clearing results 
• To clear the contents of a single cell, move to the 

cell and press the Delete key. 
• To clear the contents of a column or multiple 

columns, select the column/s and: 

• Click the Cut icon in the toolbar. 
OR 

• Right-click to bring up a menu from which you select Cut. 

• To change a non-comment value you have already entered, it is not necessary to delete the current value first, but simply move to 
the cell to be replaced and follow the same procedure as if entering data from scratch, ie either type in the new result; or select it 
from the drop-down list. 

• To change or edit the contents of a comment cell, go to the appropriate cell, and move into edit mode by: 

• Pressing F2. 
OR 

• Clicking once in the cell when the cell is the selected one. 
• Once in edit mode, you may highlight all or parts of the text and overwrite or delete them. Or you may move the mouse pointer 

to a particular spot and add further text etc. 

Cut, copy and paste 
You may cut, copy and paste: 

• Within the one class and from one class to another. 
• From and to Microsoft Excel or Word, or other programs that allow you to place copied text onto the Windows Clipboard. 
• The contents of one cell to another cell. 
• A column to another column, or any selection of contiguous columns to another series of contiguous columns of the same number. 

To use cut, copy and paste: 

• Highlight the cell or portion of text or select the column/s required. 
• Click the Cut or Copy icon. 

OR 
• Press Ctrl X or Ctrl C respectively. 
• Move to the cell or select the column/s in which the cut or copied data is to be pasted. 
• Click the Paste icon or press Ctrl V. 

Filling a column 
You may copy the contents of one cell up or down to all cells above it or below it in the column, ie you can fill a column: 

• Move to the cell you want to copy up or 
down. 

• Click the Fill up or Fill down icon, as 
appropriate. 
OR 

• Press Ctrl U or Ctrl D, respectively. 
• Move to and change any exceptions if necessary. 

Customising your offline files 

Once you open a class, you may change the way it appears, including the way its rows and columns are displayed, which columns are 
hidden and which visible, the order of the list of students and what is included in this list, how records are sorted, the font size of the text 
displayed, etc. 

Changing the font size 
In the Accelerus status bar, there are two tools that allow you to increase or decrease the size of the contents of the windows: 

• A dropdown box allows you to select the zoom percentage. 
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• A sliding zoom 
selector. 

The zoom setting from 
either of these will apply to 
all windows that you have 
open, including the 
Welcome Screen. 

Changing column widths 
To change the width of an individual column, eg a column 
containing comments: 

• Move your mouse pointer to the border to the right of 
the column heading and it will change to a re-size 
pointer. 

• Hold down the mouse button and drag the border to 
the desired width. 

Changing the height of all rows 
You may change the height of all rows: 

• Move your mouse pointer to the bottom border of any row, in the selection bar to the left of the Student column, until it changes to a 
re-size pointer. 

• Hold down the mouse button and drag the border down until the rows are the required height. 

Moving column positions 
You may change the order of the 
assessment item columns by selecting 
individual or groups of columns and moving 
them to another position: 

• Select the column/s to be moved. 
• Point to the highlighted column 

headings, hold down the mouse and 
drag the heading/s to their new 
position.  

• Release the mouse button and the 
columns and all their data will be moved to their new position.  

Resetting the order 
If you want to return your columns to the order that they were in when the class was first opened, as set by your Accelerus administrator: 

• Click View in the menu bar. 
• Select Reset Column Order. 

Sorting data in columns 
You can sort the data in your results window by any of the columns in the grid. For example, you might like to display the students in the 
order of their results for a particular assessment item, and then to resort them into alphabetical order based on the Student column. 

You may sort data in columns in ascending order or descending order.  

Also, when multiple columns 
are chosen and you choose to 
sort, you are in fact choosing 
the first, second, third … sort 
level automatically, working 
from left to right. 
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To sort: 

• A single column, click the column heading. 
OR 

• A series of columns, ensure the columns are in the required relative sort position, eg the first is the primary sort mode, etc, and select 
the columns. 

• Click the appropriate one of the Sort ascending or Sort descending icons. 

Viewing and hiding columns 
The first time you open a class, all assessment item columns set up by the Accelerus administrator appear. However, you may selectively 
hide columns that are not currently required, and later re-display them. 

Which assessment items are visible and which are hidden has a bearing on many functions in Accelerus. For example, hidden columns are 
excluded from the various listings that can be printed and from spell check operations. 

Via the View menu, you can select any combination of columns to view or hide, or view just those belonging to a particular tag or that are of 
a certain type of marking scheme, eg all comments. 

To view columns belonging to a particular tag: 

• Click View in the menu bar. 
• Click the tag you want to view. 

In the example shown here, just the items belonging to T1, ie term 1, have 
been selected. Those belonging to the other listed tags will be hidden, 
therefore. 

To select any combination of columns to view or to hide: 

• Select the individual or series of columns that you want to hide in the 
results grid. 

• Right-click over the column headings and select Hide column(s). 
OR 

• Click the View selected assessment items icon. 

• In the View Selected Assessment Items window: 
• If required, enter selection criteria in the column search fields to 

enable easier selection of the columns to be hidden or made 
visible. 

• Click the open eye icon of a visible assessment item to close 
the eye and, therefore, hide its column. 

• You may also make selections of rows to hide using the Ctrl 
and Shift keys and then click the Hide or Show icon, as required. 

• Click the OK button and only the columns marked as visible will be displayed. 

 

 

To show a single column that is hidden: 

• Right-click over any column heading. 
• Select Show and then the particular assessment item you want to show. 

To show all columns, click the View all assessment items 
icon. 
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Locking columns 
You may want to lock some columns so that they are 
visible but cannot be changed, eg after you have 
completed assessing the students on a particular item, 
so as to avoid accidental changes. 

• Select the column/s that you want to lock. 
• Right-click over the column heading and select 

Local lock. 

A red lock icon will appear in the column heading and 
the locked columns are automatically shaded. 

The Local unlock option in this right-click menu allows you to unlock the selected column/s. 

Note that columns that have been locked by the Accelerus administrator have a yellow lock icon. 

Colouring columns 
You may want to colour different columns, eg those belonging to a particular tag or different types of items that you want to group together: 

• Select the column/s that you want to colour. 
• Right-click over the column heading and select Colour and then select from the available colours. 

The Reset colour option in this right-click menu allows you to remove any colour from the selected column/s. 

Formatting the student column 
By default, the students in your classes will be listed using their family name, and either their given name or preferred name, depending on 
the option set by the Accelerus administrator. Therefore, when you sort the students, they will sort in alphabetical order based on their 
family name, then other name. 

If you wish, however, you may change the data that appears in the student column. For instance, you may want the first field to be the 
student’s home room, followed by the student’s family and given names, eg 10A – Smith, Mary, so that the students can be sorted into 
home group order. 

To select the information in and format of the student column: 

• Click the View menu. 
• Select Student Column Format. 

• Select the fields you require from each of the three field dropdown lists. 
Note that you may chose to leave a field blank, eg the third field if only two are required. 

• Select the character you want to 
use as a delimiter between the 
fields in the two delimiter 
dropdown lists, eg dash or 
comma. 
Again, you may leave either 
blank, if not required. 

• Note the sample text for the 
selections made and, if as 
required, click the OK button. 
The Student column will now display the students’ details using the selected format. 

Spelling and punctuation checking 

When entering comments for students, incorrectly spelt words will be displayed with squiggly underlining and you can correct these as you 
go. Right-click over the misspelt word to bring up a list of suggested replacements and select one, if appropriate. 

However, a full spell and punctuation check should be run after you have entered all comments for a particular report run: 

• To check all comments found in visible comment assessment items, click the Spell check icon or press F7. 
OR 
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• To check just a particular comment column or a 
set of columns, select the column/s, and then 
click the Spell check icon. 

• As spelling and punctuation errors are brought 
up make the required selections, eg ignore the 
error, replace it with another word, etc. 

Printing listings 

You can print out copies of results and comments, as well as listings of 
students and assessment items. 

• Make sure that the assessment items that you want to include in the 
listing are visible and those not required are hidden. 

• Click the File menu. 

• Click Teacher Listings. 

• Select the listing required, eg All Results. 

• In the case of the Result Grid listing, you will be taken directly to the 
Print window where you may choose the printer and its settings. 

• For the other listings, a Preview window will be displayed. 

• In the Preview window, you can scroll through the listing pages, and 
select the Print icon, if you want a printout. 

 
The Print Reports Using Word option in the Teacher Listings menu allows 
you to prepare and student reports using a Microsoft Word template for the 
students in your class. 
 
 

Find and replace, including finding missed results 

You may search for and replace: 

• Any particular text in your class 
• Blank cells, where you may have inadvertently missed 

entering results in a column or for a student. 
• Results where an Enter has been entered. 
 
To run a find and replace process: 

• Click the Find and replace icon in the toolbar. 

• Leave the Find What box empty if you want to search for 
blank results, or enter the text you wish to search for. 

• Choose your Search scope – usually you will click the 
All Results option button. 

• Check any of the required boxes, as required, noting the 
following: 
• If searching for blanks, click the Whole Result 

Only box. 
• If you wish to search for an Enter in any 

comment, you must click the Allow Enter in 
Find/Replace box and then press Enter in the 
Find What cell. 
The same principle applies if you want to replace 
particular text with an Enter. 

• Click the Find Next button. 
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Creating class assessment items 

Teachers of a class may create assessment item columns in their classes for use by teachers of the class, eg to keep track of student 
results in a series of tests or assignments, etc: 

• Click the New class assessment item icon in the toolbar. 
If not already visible, the window’s bottom panel will be 
displayed. 

• In the Assessment Item (Class) panel: 

• Enter a code for 
the item, or accept 
the default code 
which will begin 
with CLA and 
increment as you 
add more class 
items. 

• Type a description 
of the item, eg Class Test 1 

• Select the marking scheme that applies to the particular item 
from the dropdown list. 

• Optionally, select a tag for the class item, used only for 
grouping and viewing purposes. 

• If required, enter a calculation for the assessment item. 

• Repeat for other class assessment items you require. 

• Click the Save icon. 

A column will appear for each class assessment item you have created. The 
column will be shaded lime green and a teacher icon will appear in its 
column heading, as shown here. 

You may move the columns and perform all other column operations on the 
column, as required. 

Viewing Class and Student Details 

You may view all of a student’s details, including any 
special information about the student that has been 
made available to you by the Accelerus administrator, 
by double-clicking the student’s name in the results 
grid. This will open up the student’s window, 
displaying all of their details. 

A Custom Properties tab will also appear, displaying 
any special properties defined by your school that 
apply to the student, eg their ethnic background, 
medical conditions, etc. 

In addition, from both the result grid and single 
student view, you may click the Open class details 

icon, in the top right corner, to display additional information about the class in 
its own tabbed window. 

Note that all of the fields in the class and student windows appear greyed out 
for teachers working in their offline files. 


